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In an office setting you might want to save the downloaded plumbing fixture drawings to a
“Plumbing Fixtures” folder on your hard drive for convenient access in the future.

You will need to have access to the Internet for the next several steps...
1. Open your Internet Browser; this book uses MS Internet Explorer.
Next you will be instructed to browse to a major plumbing manufacturer’s website.

2. Browse to the Kohler website by entering the URL www.kohler.com and then
press Enter... ordlick Go. Or go directly to: http:/ /www.us.kohler.com/index.jsp

‘€ KOHLER Kitchen & Bath Plumbing Fixtures: Sinks, Toilets, Bathtubs, Faucets - Microsoft Internet Explorer fea=s

@Q < [ ieepi/funnkohler.com/corporste/indexhtrl = [ 42| x | 8 Google o -

¢ Favorites - 5 @) AjaXplorer - - @9 Altiris Symantec Manage... ] Customize Links (@) RTC 2011 North America & Get More Add-ons ~

K KOHLER Kitchen 8 Bath Plumbing Fixtures: Sinks.. fii = B v [ & v Pagev Safetyv Toos~ @v

KOHLER.

ohler Plumbing [l

m

hittp://www.us kohler.com/ & Internet | Protected Mode: Off 3 v ®10% -

FIGURE 4-1.1 Website: www.kohler.com

FYI: As you should be well aware, websites can change at any given moment. Companies often
update their websites as new content becomes available or a fresh new look is desired. Even the
model numbers change from time to time. So if the screen shots shown bere are different than what
_you see on_your screen you will have to interpret the steps based on what you see; you will likely still
have access to the same content.

3. Click on Kitchen and Bath and then click in the textbox next to Search at the top of
the webpage; type K-4325-0 and press Enter.
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4. Click directly on the toilet image (the one without the bedpan lugs) (Figure 4-1.2).

== Take a minute to review the features of this
toilet fixture.
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. (Lp——— e The previous step reveals specific design and

installation information for the toilet (Figure
4-1.3).
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FIGURE 4-1.2 Website: www.kohletr.com; search results
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FIGURE 4-1.3 Website: www.kohler.com; downloading CAD Files

The next link you are instructed to click will allow you to save a CAD file of this fixture to
your hard drive. If in a classroom setting, your instructor may direct you to save these files to

a different location.

6. Under Template & Symbol for Downloads, right-click DWG next to 2D Plan
View and then select Save Target As... from the pop-up menu.
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Make sure you selected DWG CAD Files and not DXF CAD Files. The former is the native
AutoCAD file format and the latter is a file format conceived by Autodesk to allow
designers to share CAD information between AutoCAD and other CAD programs not
written by Autodesk. The DWG file format is more readily inserted into your current
drawing than DXF (Drawing eXchange Format).

7. Click Save in the File Download dialog box (Figure 4-1.4a).

FYI: You may not get this prompt; if not, skip to the next step. ..

File Download (3]

Do you want to open or save this file?

. MName: 4325pin.dwg
BWE Type: AutoCAD Drawing
From: www.us.kohler.com
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Always ask before opening this type of file
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FIGURE 4-1.4A  Saving a file from the Internet

8. Browse to your Documents folder (Vista or Windows 7) or My Documents folder
(Windows XP) and click Save; see Figure 4-1.4b.
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FIGURE 4-1.4B  Saving a file from the Internet

You now have a copy of the toilet fixture on your hard drive and it is ready to be placed in
your floor plan!
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The file you just downloaded is named 4325pln.dwg (unless you renamed it in the previous
step); the name is the model number plus the view (pln for plan view in this case). If you
open the file directly you will notice the origin has been conveniently located at the back/
center of the fixture and all lines are on Layer zero. Having all lines on Layer zero is
preferred; this way all lines in the Block will take on the properties of the Layer the Block is
placed on.

Next you will be instructed to download the other fixtures required for your floor plan.
Rather than giving you step-by-step instructions you will simply be given the model
numbers; you can then find and download the other fixtures using similar techniques to
those just covered.

9. Download the other two views (front and side) of the toilet.

10. Using techniques previously covered, download all three views (plan, front and side),
from the Kohler website, for the plumbing fixtures listed below:

e K-2007-0 Kingston™ wall-mount lavatory
e K-5024-T Dartfield™ Urinal
e K-5250 Serra™ Drinking Fountain

When finished you should have the following files listed in your My Documents folder:

e 5250sde.dwg e 4329sde.dwg
e 5250pln.dwg e 4329pln.dwg
e 5250frt.dwg e 4329frt.dwg
e 5024tsde.dwg e 2007sde.dwg
e 5024tpln.dwg e 2007pln.dwg
e 5024tfrt.dwg e 2007frt.dwg

Next you will draw a “lavatory system” from another major plumbing manufacturer called
Bradley Corporation. You can also download this one from the Internet (and you will be
given the URL), but the file is composed of multiple views and information, plus it is in a
ZIP file, which makes for more work (as far as this tutorial is concerned).

11. If you prefer to try the download, browse to the following URL:
http: //www.bradleycorp.com/products/fixtures/lavsystems/ss/
viewproduct.jsp?pgid=1196
(This may change; see item “b” below.)

a. Click the link to download the CAD Files.
b. You can also search for Express Lavatory, Model SS-2N
12. In a new drawing, draw the Lavatory System shown in Figure 4-1.5; make sure the
origin is at the back and centered.
a. Approximate all dims and arcs not specified.

b. Draw everything on Layer zero.
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Exercise 4-3:
Stairs and Elevators

Introduction

In this exercise you will add the stairs and elevators. There are several things to consider
when drafting and designing these components within a building. Similar to the plumbing
fixtures, you will download the elevator drawings from the internet.

Adding the Passenger Elevators:

Elevators come in several models and sizes. In this tutorial you will be adding two passenger
elevators and a service elevator. Selecting the model and size depends on several factors such
as: expected number of passengers in a given period of time, number of floors served,
budget and speed to name a few.

In this made-up library project, the passenger elevators will have high quality finishes and are
intended primarily for people (i.e., the public and staff) and book carts. The service elevator
is only accessible by staff and has durable finishes to withstand large items being moved in

and out on a regular basis.

The following steps could aid in determining the elevator shaft size. However, this
information was previously given when you drew the walls.

Again, you will need access to the Internet before proceeding with this exercise.

1. Open your Internet Browser; this book uses MS Internet Explorer.
Next you will be instructed to browse to a major elevator manufacturer’s website.

2. Browse to the ThyssenKrupp Elevator website by entering the URL
www.thyssenkruppelevator.com and then press Enter (Figure 4-3.1).

3. Click the Architect Direct Pro link near the top of the webpage.

4. Now select the View All Models link (i.e., a link on the far left).
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FIGURE 4-3.1

Elevator manufacturet’s website

5. Scroll down and select Gearless — 3000 Ib. Capacity (Figure 4-3.2):

Capacity Oildraulic synergy Machine Room-Less Traction
Seli-Supported Building-Supported
AMEE Conventional 855 300R 300s 300R 300s 300E Gearless
2100 [ (] (] ® ®
2500 o ® ® L @ @ ® ® ®
3000 L] ® ® L o o ® ®
3500 o ® ® L @ @ ® ® ®
4000 L] L] ® ® ®
S i .« net
FIGURE 4-3.2 Elevator manufacturer’s website

6. Click the icon under the label Drawings/ non-seismic (see image below):

Model: Type:

Gearless 30

synergy 300E MR 3000

Data:

Gearless @

Gearless @

Drawings: TK Specs: BIM Models:
non-seismic seismic
X, y = |
*
~
ray B = |
'..l“
Click here
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7. Right-click the DWG icon next to 200, 350, 500 - Center Opening - Front -
Hoistway & Machine Room View as shown in Figure 4-3.3.

Right-click here
to download the

drawings
200 Front & Rear (S?rit;usrslﬂsi?:b} B >
200, 350, 500 Center Opening Front HU(i;t;“;‘;nae”g;“l?rﬁrligi;ﬂ‘;m | &
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200,350,500  Center Opening Front H‘]Egt‘;‘:;“uf;dsrrfbc?gj&ﬂf}m | 5
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ann 98N EAN ey Crnnt @ Dannr Hoistway and Machine Room 5] =

FIGURE 4-3.3 Elevator manufacturetr’s website

8. Click the Save Target As... command (Figure 4-3.4) and browse to your Documents
ot My Documents folder.

a. If needed, rename the file extension from “.html” to “.DWG”.

(Structural Slab) s = -

) Hoistway and Machine Room
200, 350, 500 Center Opening Front (Machine Beam - Beam)

: Hoistway and Machine Room
200, 350, 500 Center Opening Front (Machine Beam - Machine)

Open Link

- : Open Link in New Tab
200, 350, 500 Center Opening Front FEETEPE L EE T [t b= e

(Structural Slab - Open Link in New Window

= = Save Target As...
200, 350, 500 Center Opening Frant FEETEE Tal TER TE 6 < %
(Structural Slab - Machine) Print T
o _ rint Target
M e a0 — itk a - i

FIGURE 4-3.4 File Download dialog

You now have an AutoCAD drawing file named PME 30-20_50HMR PLAN I CO
SINGLE-MM.dwg saved on your computer’s hard drive. This drawing is shown in Figure
4-3.54, and is packed with information. As you can see, details about the elevator shaft and
the elevator machine room are given. In your case, this is more information than you need.
So, you will open the drawing and Copy/Paste what you need into your floor plan.
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FIGURE 4-3.5A  Contents of drawing file just downloaded
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9. Open PME 30-20_50HMR PLAN I CO SINGLE-MM.dwg (i.c., the elevator
drawing just downloaded).

10. Zoom in to the elevator shaft plan view on the right.

Layer Freeze: a useful tool:

Next you will use a tool to freeze a Layer just by selecting objects on the screen. This will
help you to select just the parts of the drawing you need.

11.

12.

13.

Set the current Layer to 0 (i.e., zero).

T1P: Click the Layer drop-down list from the Home tab and scroll up to Layer gero and click
on ity as long as nothing in the drawing is selected, this will make the selected Layer current.

From the Layers panel on the Home tab, & &g 8 8 % 5%

select the Freeze icon (see image to right). Unsaved Layer State -
T1P: Explode (on the Modify panel) any Blocks in ) Crof [ A-WALL M
this drawing so you can control the Layer color when it Layers « |

is loaded into the library floor plan.

Click on all the text, dimensions and centerlines until the drawing looks like Figure
4-3.06.

TIP: If you click on the wrong object and a Layer is frozen by mistake, type U and press Enter
on the keyboard. (This is not the main Undo command.)

The elevator drawing is almost ready to be

copied to the clipboard and pasted into your

L]
= floor plan.
| Before you copy the drawing to the clipboard,

you will fix the broken lines (they were trimmed
to accommodate notes and dimensions — which
are now frozen).

Also, all the visible linework is currently on a
T Layer named “Object” which does not conform

to your office standards; you will fix this too.

.
T L
L7
— 1 N[
FIGURE 4-3.6  Elevator drawing
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Adding the Service Elevator:

This elevator is near the loading dock area (west side of the building) and is only accessible
by the library staff. It is rated for a higher capacity than the passenger cars (30001bs. vs.
50001bs.). The cab size is also larger to make it easier to move objects in and out.

You will be given minimal information with the expectation that you use the knowledge
previously learned to locate and insert the drawing data.
30. Place the service elevator per Figure 4-3.12, p/us:
a. Use the same mfr:  ThyssenKrupp Elevator
b. Type of application: Gearless
Capacity: 5000
Model: synergy 300E MR 5000 (non-seismic)

&

e. Note the door orientation.

Hoistway and Machine Room -E

200, 350, 500 Single Speed RH (4°- 07) Fraont (Machine Beam - Beam)

K<

o
- i — T %] L 1 - - *D -
——
T T
| |

FIGURE 4-3.12  Service elevator added to plan
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